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                                              Electronic Models 
 
 
►Introduction The advent and use of molecular modeling has revolutionized the science of 
organic chemistry. You may be familiar with SpartanView, which allows a viewer to look at 
pre-made models and modify them on the screen. SpartanBuild is a companion software 
program that provides viewers with three primary capabilities: to build molecules, to view 
these molecules in five different model formats, and to measure distances and angles on a 
model. This guide consists of two parts, a tutorial on the use of SpartanBuild and a set of 
practical exercises, which require SpartanBuild. The tutorial is designed to be both a learning 
primer and a user’s guide. You can refer to it at any time to refresh your memory about 
specific capabilities of SpartanBuild. The practical exercises are designed to reinforce the 
knowledge you have acquired thus far in your study of chemistry in a game-like and fun 
manner. First, the basics of the program will be described, including basic mouse commands, 
certain screen features, Menu Bar items, and Toolbar icons. Then, we shall explore 
SpartanBuild by following a normal pattern that a typical user would follow. We shall build 
models of molecules and explore the various ways of viewing and making measurements on 
them. That is, we shall execute the three principle functions of SpartanBuild (i.e., build, view, 
and measure). The goal is to make you proficient in the use of SpartanBuild, so that you can 
use it as a learning enhancer. 
 
SpartanBuild Tutorial 
 
►Setup SpartanBuild 
Insert your CD (ISBN: 0-534-37364-X) into the computer and open the disc. Double click on 
WFKIT (press the left mouse key twice with the arrow pointed at WFKIT, the colored icon 
with a B on it). The electronic model kit appears.  
 
 ●General Commands The command to click means to depress the left mouse key 
(LMK) one time. Double click means to depress the LMK twice in rapid succession. When 
the right mouse key is required, it will be specifically identified as RMK to distinguish it 
from the LMK. The mouse controls a white arrow or pointer on the screen. Move your 
mouse to see the motion of the pointer. The command “click on” means to place the pointer 
on the specified object and depress the LMK. 
 
►Screen Features◄ SpartanBuild initially opens with several visible features. 
Each of these features will be described briefly here for familiarization and in more 
detail, as necessary, later. 
  

●Title Bar The left side of the title bar contains the logo, B, and name of the program 
(SpartanBuild), and the right side of the title bar contains three standard command boxes. 
   
                  ◦Minimize, Maximize, and Close There are three boxes on the right-hand side of 
the title bar. Place the pointer over each box until the name of the box appears. The name will 
remain visible for approximately five seconds. These are standard commands. Click on the 
middle box or “Maximize”. This brings up a full screen. Otherwise, the bottom portion of 
SpartanBuild is obscured by the windows data bar at the bottom of the page. Click on 
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Maximize every time you open SpartanBuild. Note that the Maximize box changes to 
“Restore Down” after you have clicked the maximize box. That is, Maximize and Restore 
Down are reversible operations. 
 
 ●Menu Bar The Menu Bar is the horizontal group of seven items (five to the left and 
two to the right) at the top of the screen, starting with File. Click on “File” and the File menu 
becomes visible. Slowly move the pointer from left to right across the Menu Bar. As the 
pointer passes each menu item, the contents of that menu become visible. We shall explore 
these items later. By clicking on any menu item, you can read the contents of any other menu 
item by moving the pointer as described above. 
 
 ●Toolbar The Toolbar is the horizontal group of eleven icons, starting with the V 
icon. Click on each icon in turn, starting with the V icon. Note that a command appears in the 
lower left corner of the screen each time a new icon is clicked. The command tells the viewer 
what to do after that particular icon is active (has been clicked). For example, clicking the + 
icon results in the command to “Select an open valence.” Click on the “+” icon. Note that the 
selected icon appears slightly depressed with respect to the other icons. The name of the + 
icon is Add Fragment. The + icon is more commonly called the build icon, but its name on 
the Toolbar is Add Fragment, which means build. When you open SpartanBuild, the build 
icon is active.  
 
 ●Model Kit The Model Kit is on the right side of the screen. It resembles a standard 
model kit. You can select atoms from the kit, and use the atoms to build models of 
molecules. The kit contains 20 different individual atoms and two sets of bonded atoms in the 
form of groups or rings from which to choose. 
 
  ◦Individual Atoms In turn, click on several of the individual atoms in the kit. 
Note that the selected atom changes from black on a white background to black on a white 
background. A graphic of the selected atom appears in the box just above the 20 symbols.  
 
  ◦Groups What is a group? A group is not a complete molecule but a partial 
structure of two or more atoms joined by covalent bonds. Other atoms must be bonded to a 
group before it becomes a molecule (i.e., before the molecular model is complete). If you do 
not complete the model by adding other atoms, the program will automatically complete the 
molecule for you by adding H atoms when you try to make a measurement on the model or 
view it in another form. Click on “Groups” then click on the adjacent “▼.”  A menu of six 
groups opens. Click on “Amide.” The structure of an amide group appears in the box above 
the kit. Draw this structure on a piece of paper for practice. 
 
  ◦Rings What is a ring? A ring is group of atoms joined by covalent bonds in a 
continuous loop. You may start at any atom that is part of the ring and follow bonds from one 
ring atom to the next until you return to the starting atom. Click on “Rings” then click on the 
adjacent “▼.” A menu of eight rings opens. Click on “Cyclopentane” and draw the structure 
of cyclopentane as it appears above the kit.  
 
 ●Insert The Insert button is located at the lower right corner of the screen. Two 
distinct and independent models can be built and viewed on the screen simultaneously. Build 
the first model, and then click on “Insert” and build the second model. Thereafter, additional 
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models can be built and viewed simultaneously by clicking on Insert before building each 
model. Each model in the set can be moved or rotated independently of the others on the 
screen. Before we continue, the screen should be clear. If your screen is not clear, click on 
“Edit” from the Menu Bar and then click on “Clear.”  
 
►Menu Bar Items Look at the top of the screen where you see “SpartanBuild.” On the next 
line, you see five menu items on the left side of the screen and two on the right. On the left 
side, you see “File, Edit, Model, Geometry, and Build.” On the right side, you see “Options 
and Help.” We will explore these menu items one at a time, but not in the exact order as they 
appear on the Menu Bar.  
 

●File Click on “File” to open the File menu. You see only three options, “Print, Print 
Setup, and Exit.” These commands are self-evident. 
 
►Build◄ The building of models is associated primarily with the Build Menu. 

 
●Build A SpartanBuild user normally builds, views, and measures in that order. 

Thus, we’ll start with the Build Menu. Likewise, because the Zoom, Rotation, Translation 
and Spin operations are really part of the build process. We’ll consider these functions before 
we continue with the other items on the Menu Bar. From the Menu Bar, click on “Build.” 
The Build menu consists of six options. The first option is View. View is really not a build 
tool. View is more appropriately used with the Model Menu and will be discussed there. 
View is an option in the Build Menu to simply provide redundancy. The next four options in 
the Build menu are basic building tools.  
   

◦Add Fragment With the screen clear, click on the “Add Fragment” option 
from the “Build” menu. Note that the + icon is active. Adding a fragment is the most 
fundamental operation of SpartanBuild. We shall build methane, the simplest hydrocarbon. 
Go to the Model Kit, click on the “C” with four single bonds. The C become active 
(highlighted). Click anywhere in the green area. A carbon atom with four single bonds 
(methane) appears, but its H atoms are not immediately apparent. Look closely and you will 
see that the four bonds coming from the gray carbon atom turn yellow at the mid-point of the 
bond. The yellow half of each bond represents an H atom or an open valence. When you are 
finished building your model, the program will automatically add H atoms to any open 
valence (yellow tip). However, we are still in the build mode. Before continuing with the 
build options, some useful operations related to building molecules will be introduced. 

 
  ◦Minimize Click on “Minimize” from the “Build” menu. Note that hydrogen 
atoms automatically appear bonded to all free bonding sites (valences), and the half of the 
bond that was yellow now appears white. The molecule is said to “sprout” hydrogens. The 
Minimize command builds the most stable (lowest energy) model of methane. The model 
built with the Minimize command is called a ball and wire model. That is, the C and H atoms 
are balls, and the bonds joining atoms are wires. The carbon atom is gray, and the four 
hydrogen atoms are white. The colors are not pure but slightly off (i.e., hydrogen is an off-
white color). 
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 ■Selecting Minimize or the E icon also calculates the energy of the molecule, 
which is shown at the lower right corner of the screen. What is the energy of methane in 
kcal/mol?  
 
►Zoom (Enlarge—Reduce Model) 
Depending on the application, it might be desirable to increase or reduce the size of a 
molecule. The zoom feature allows a user to change the size of the displayed molecule. 
 
 ● Start with the white arrow (pointer) at the bottom of the screen. Depress and hold 
the “Shift” key on your keyboard. Simultaneously, depress and hold the RMK. With both 
keys depressed, move the pointer upward to the top of the screen. This operation increases 
the size of your methane molecule. Release the mouse key and return the white arrow to the 
bottom of the screen. Again, simultaneously depress both keys (Shift + RMK) and move the 
white arrow to the top of the screen. You can repeat this operation until you make the 
molecule the size you desire. Depressing both keys (Shift + RMK) and moving the pointer 
downward reduces the size of the model.  
 
 ●The larger the methane molecule appears, the easier it is to see the three 
dimensional aspects of the model. You may increase or decrease the size of models during 
the remainder of this tutorial to suit your personal style or to keep the models on the screen. 
 
►Rotation of Whole Molecule A molecule rotates when it tumbles in any direction (three-
dimensions) about a stationary point. Rotation does not imply movement through space.  
 
 ●Move the white arrow (pointer) until it is just above your methane molecule. 
Depress and hold the LMK. Simultaneously move the mouse so that the white arrow makes 
circles around your methane molecule. Notice what happens when you simultaneously hold 
the LMK and swirl the mouse. With a combination of up and down and 
clockwise/anticlockwise swirls with the mouse, you can orient the molecule in any manner 
you please. 
 
 ●For practice, orient your methane molecule three different ways, as shown in Figure  
1. 
 

Figure 1
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►Translation When a molecule moves through space by changing its three-dimensional or 
x, y, z coordinates, the molecule is undergoing translational motion. Translation does not 
imply spinning. 
 
 ●Depress and hold the RMK, then move the pointer up and down and right and left in 
the green area of the screen. These operations allow you to position the molecule any place 
on the screen you desire. The model moves from one location to another by translation. 
 
 ●For practice, move your methane molecule, in turn, to each corner of the screen. 
 
 ■ Can a real molecule undergo rotation and translation at the same time? Can a 
molecule in SpartanBuild undergo rotation and translation at the same time? Explain the 
difference between rotation and translation of a molecule. 
  
  ◦Add Fragment (Continued from above) Click the + (Add Fragment) icon 
to return to the build mode. The model on the screen can be modified. The four bonds of 
carbon are again half gray and half yellow. The yellow tips are open or available bonding 
sites called open valences. Note that the command line at the bottom left of the screen reads, 
“Select an open valence.” An open valence is a yellow tip. Click at the very end of any one 
of the yellow tips. Ethane is built, because the tetrahedral C atom with four single bonds is 
still the active atom in the 20-atom model kit. You can add as many fragments as you please. 
Click on another open valence and propane is built. Click on an open valence that originates 
from the middle carbon of propane and isobutane (2-methylpropane) is built. Click on “E” 
the Minimize icon and the molecule appears as a ball and wire model, showing the most 
stable conformation of isobutane with its hydrogen atoms visible. 
 
►Rotation About a Selected Bond (Spin) Two common properties of organic molecules 
are the rotation about carbon—carbon single bonds and the restricted rotation about multiple 
bonds.  
 
  ●With isobutane on the screen, depress the “Alt” key on the keyboard. Depress and 
hold the LMK and move the mouse up and down. This action causes rotation (spinning) 
about the last-made single bond. The last-made bond is dashed (connected to the residual 
molecule by a dashed bond). To rotate about another bond (or if spinning did not occur on 
you model) go back to the build mode by clicking the “+” icon. Click in the middle of a 
carbon—carbon bond.  This action changes the bond from a solid line into a dashed line. The 
dashed line is the “active” bond about which rotation will occur. Then repeat the “Alt + 
LMK” procedure to rotate about the newly dashed bond. With “+” active, click at the gray-
yellow mid-point of a free carbon valence and repeat the “Alt + LMK” procedure. This 
action causes rotation about the dashed carbon—hydrogen bond.  
 
►Changing a Bond Length A dashed bond may be elongated or shortened. You might 
want to do this to get a better view of a portion of a molecule. 
 

 ●With isobutane on the screen, depress the “Alt” key on the keyboard and the RMK. 
Move the mouse up and down. The dashed bond is lengthened when the mouse is moved 
upward and shortened when the mouse is moved downward. The operation works only on a 
dashed line. The last-made bond will be dashed in the ball and wire model. Another bond can 
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be made to be the dashed bond in the model by going to the build mode and clicking on the 
mid-point of the bond. 
 
►Spinning a Molecule Spinning differs from rotation in SpartanBuild in that spinning is 
two-dimensional and rotation is three dimensional.  
 
 ●With isobutane on the screen, simultaneously depress “Shift + Ctrl” on the 
keyboard. Depress the LMK and move the cursor upward. The model makes a clockwise 
spin. Move the cursor downward and the model makes a counterclockwise spin. 
 
  ◦Delete Click on “Delete” from the “Build” menu. The command line (lower 
left corner) reads, “Select object to delete.” Do not click on an open valence, but click on any 
of the three equivalent carbon atoms. A methyl group is deleted, leaving propane. 
  ◦Make Bond Click on “Make Bond” from the “Build” menu. You are going 
to make cyclopropane by joining the end carbon atoms of propane. The command line reads, 
“Select two open valences.” What are open valences? They are the yellow ends of bonds. Do 
not click carbon atoms, they are not open valences. Click on two yellow tips in succession. 
First, click on an open valence at one end of your propane model. Then, click on an open 
valence at the other end of the molecule. By selecting two open valences, you created a bond 
joining their carbon atoms (i.e., cyclopropane.). Click the “E” icon and, if necessary, rotate 
the model to get a better view of it. You should have a nice model of cyclopropane. 
  ◦Break Bond Click on “Break Bond” from the “Build” menu. Before 
continuing, note that the carbon—carbon bonds are solid gray, whereas the carbon—
hydrogen bonds are half gray and half white. Also note that the last bond formed in the build 
mode appears as a dashed line (C----C) instead of a solid line (C—C). With Break Bond 
selected from the Build menu, click on the center of any carbon—carbon bond. Yellow tips 
appear where the bond breaks, creating two open valences. Although the yellow color 
between the two carbon atoms indicates that a bond has broken, it is sometimes difficult to 
see the new bonds. Click on the “E” icon. When the model adjusts to its most stable 
conformation, the new bonds become clearly visible. 
   

●Edit Click on “Edit” to open the edit menu. You see three options, “Undo, Copy, 
and Clear.” The “Undo” and “Copy” commands work as they do in the Word program. 
Clicking “Undo” deletes the last command you made. Clicking “Copy” copies the structure 
to a clipboard from which it may be pasted to another file (e.g., to a PowerPoint slide).  

 ◦Clear This command clears the screen. Unlike the Exit command in the File 
menu, Clear allows you to continue building models. Click on “Clear.” The propane model 
disappears, and you are back in the build mode. Click anywhere in the green space and 
methane reappears, providing the tetrahedral C atom is still highlighted in the model kit. 
Click on the very end of one of the yellow tips (free valence). A methyl group (the 
highlighted fragment in the kit) is now bonded where you clicked, making ethane again. 
Click on “Undo” from the “Edit” menu. The methyl group added by your last command is 
deleted, leaving methane. Click on “E”. Methane appears as a “Ball and Wire” structure.  
 
●Building Multi-atomic and Multiple Molecules  
 
 ●Multi-atomic Molecules  
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●Alkanes Building complex molecules involves adding fragments. Build 
methane and click the + icon. Highlight the tetrahedral carbon in the kit. Click on one of the 
yellow tips and ethane appears. Click on an end carbon’s yellow tip again and you get 
propane. Continue until you have made pentane. Click E. Zoom the molecule and note the 
clarity of the apparent three-dimensional structure. 

 
  ●Alkenes From the Edit menu, clear the screen. Click the + icon. Highlight a 
double-bond carbon. Click on the screen. Click on the end of the two yellow lines and a 
double bond between two carbon atoms appears. Clear the screen. Click on the screen, and a 
double bond fragment appears. This time click on one of the single yellow lines. A single 
bond is formed between the two carbon atoms, making two double bonds available. An 
important feature of the build mode is that like valences must bond to like valences. Thus, 
clicking the double bond yellow tip produces a double bond, and clicking the single bond 
yellow tip produces a single bond. 
 
  ●Alkynes Clear the screen. Highlight the triple bond carbon in the Model Kit. 
Click on the screen. Click on the three line bond and you get a triple bond. Click on the one 
line bond and you get a single bond. Like valences bond to like valences. 
 
  ●Oxygen There are three oxygen atom choices, one with two single bonds, 
one with a double bond, and one with three single bonds and a positive formal charge. Clear 
the screen and build a methane model. Highlight the double bond oxygen and click on a 
yellow tip. You get an audible no-no, meaning that you have tried to join unlike valences. To 
add a double-bond oxygen to an existing fragment, the fragment must have a double bond 
site open (i.e., a yellow tip with two lines). Clear the screen, click on a double bond carbon in 
the kit, then on the screen. Highlight the double bond oxygen and click on the double bond 
on the screen. A carbon—oxygen double bond appears. This is a carbonyl group, an 
important group in organic chemistry. Highlight the single bond oxygen in the Model Kit and 
click on a carbon single bond on the screen. You have a carboxyl (carbonyl + hydroxyl) 
group. 
 
  ●Other Heteroatoms The other atoms in the kit are manipulated exactly as 
oxygen is manipulated. There are five options for nitrogen. Take care to bond like valences. 
You will get a no-no signal if you try to join unlike valences. 
 
  ●Groups Clear the screen. Click on “Groups” and select “Carboxylic acids” 
from the dropdown menu. Click on the screen and the carboxyl group appears. Add a methyl 
group to the free valence from carbon and click “E”. Acetic acid appears. The other six 
groups are built in the same way the carboxyl group was built. 
 
  ●Rings Clear the screen. Click on “Rings” and select “Cyclohexane” from the 
dropdown menu. Click on the screen and on “E” and cyclohexane appears. The other seven 
ring commands work similarly. 
 
 ●Multiple Molecules on the Screen Multiple models are made by clicking “Insert.” 
Build the first model as usual, then click “Insert” and build the next model, etc. Build a 
model of methane, click “Insert” and build a model of ethane. The models can be moved or 
rotated individually or as a group. The above-described rotation and translation commands 
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move the entire set of molecules on the screen. To rotate or translate individual molecules, 
the program must be in the build mode. Highlight one of the molecules by clicking on it. 
Depress “Ctrl” and use the LMK to rotate the highlighted molecule. Depress “Ctrl” and use 
the RMK to translate the highlighted molecule. Move the model around and then clear the 
screen. 
 
►View◄ The viewing of models is associated primarily with the Model menu. 
 

●Model Build a methane molecule. Click on “Model” to open the model menu. You 
see five options above a line and two below the line. The five options above the line provide 
five different ways to view a molecular model in Spartan. These five options are “Wire, Ball 
and Wire, Tube, Ball and Spoke, and Space Filling.” The two options below the line are 
“Hydrogens and Labels.” These two options allow us to remove hydrogen atoms from a 
model if we wish, or to label all of the atoms or defined planes in the molecule. Note that the 
“Ball and Wire” and “Hydrogens” commands already have a check mark. The checked items 
in the “Model” menu define the picture on the screen. Thus far, we have been in the build 
mode. We cannot change the model from “Ball and Wire” until we are in the view mode. 
Click on the “V” icon (directly below “File” on the toolbar) to change the mode from build to 
view.  

 ◦With the V icon active, click on “Wire” from the “Model” menu. The 
methane molecule now appears as a wire model. 

 
 ◦With the V icon active, click in turn on “Ball and Wire,” “Tube,” “Ball and 

Spoke,” and “Space Filling” from the “Model” menu. These names describe the models 
shown on the screen. These options allow you to view a molecule in the way that best allows 
you to gain the information you seek. 

 
 ◦With the V icon active, click on “Ball and Wire” to return to that model of 

methane, and then click on “Hydrogens” from the “Model” menu. Clicking on “Hydrogens” 
removes the check from the menu and also removes the hydrogens from the screen, leaving 
only the carbon atom of methane visible. Click on “Hydrogens” to restore the H atoms to the 
model. The default condition is for the H atoms to be visible. 

 
 ◦With the H atoms visible and methane as a ball and wire model, click on 

“Labels” from the “Model” menu. Each atom is labeled. With each atom labeled, two or 
more people can view the model and have a common frame of reference. Labels are only 
visible on wire and ball and wire models. Click on “Labels” to remove the labels from the 
model. The numbering system in “Labels” is not the same as the IUPAC system, and the 
label numbers depend on the order of formation of the partial structures. 
 
►Measure◄ The making of measurements on models is associated primarily with 
the Geometry menu. 
 
 ●Geometry Click on “Geometry” to open the geometry menu. You see three 
command options above a line, and two command options below the line. The three options 
above the line are commands that allow a user to measure various aspects of a molecule. The 
measurement commands are “Measure Distance, Measure Angle, and Measure Dihedral.” 
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The “Measure Distance” command allows the user to find the distance between any two 
atoms in a model in Angstrom units (Å); the two atoms need not be bonded to each other. 
The “Measure Angle” command allows a user to measure any angle in degrees (º) made by 
three atoms. The “Measure Dihedral” command allows a user to measure dihedral angles in 
degrees (º). A dihedral angle is an apparent angle made by four atoms. The two command 
options below the line are “Define Point and Define Plane.” These commands are not for 
making measurements but for helping the viewer see symmetry aspects of a molecule or 
clarify the structure in some way. The “Define Point” command allows a user to highlight 
any atom or multiple atoms as points for reference or to create or define a point on an atom in 
the molecule or on a bond between two atoms. The “Define Point” command is active only 
on a ball and wire model. Highlighted atoms are visible on ball and wire models only. 
Defined points are visible on ball and wire models when the point is midway between two 
atoms. Defined points are visible on wire models when the point lies on an atom. From plane 
geometry, three points define a plane. The “Define Plane” command allows us to visualize a 
plane that is common to any three atoms by selecting those atoms. This tool can be very 
useful in helping a beginner visualize organic molecules. The five options in the geometry 
menu are also accessible by five icons on the toolbar. Collectively, these five icons are 
known as the Geometry Toolbar.  
 
  ◦Measure Distance With methane on the screen in a ball and wire model, 
click “Measure Distance” from the “Geometry” menu. Label the atoms by clicking on 
“Labels” from the “Model” menu. Enlarge the model if necessary. Click on H1 and then C1. 
What is the H1—C1 bond length?_______ (Look in the lower right corner of the screen.) 
Find the H2—C1 bond length.______ Note: After you measure one distance by clicking two 
atoms, you can continue directly to the next measurement without clearing the last operation. 
How does the H2—C1 bond length compare to the H1—C1 bond length? 
_________________________________________________ From your measurements, what 
is the carbon—hydrogen bond length, rounded to one decimal place, when carbon is sp3 
hybridized?_________ Alternatively, you may click on the midpoint of a bond to find the 
distance between two bonded atoms. Click on any C—H bond where the gray and white 
halves meet. Read the bond distance at the bottom right corner of the screen. Note that the 
selected bond or two selected atoms turn into a golden color when they are highlighted. 
 
  ◦Measure Angle With methane on the screen with labeled atoms, click 
“Measure Angle” from the Geometry menu. Click on H1, C1, and H2 in that order. Rounded 
to one decimal place, what is the H1—C1—H2 angle?_____  What is the H1—H2—H3 
angle?________ How does the H3-C1-H4 angle compare to the H1—C1—H2 
angle?______________________________________________ Note that it is unnecessary 
for the three atoms to be bonded; an angle can be found for any three atoms in the structure. 
 
  ◦Measure Dihedral Clear the screen, build a model of ethane and click “E.” 
Click “Measure Dihedral” from the Geometry menu. Enlarge the model if desired. If the 
label option is not active, click on “Labels” from the Model menu. Click on an H bonded to 
C1 and it will turn a gold color. Click on C1 and it turns golden. Then click on C2 and on an 
H atom bonded to C2. You have clicked on four atoms in all, and they are all golden. Rotate 
the molecule so that C1 completely obscures (eclipses) C2. You will see a V shape, made by 
the three visible highlighted (golden) atoms. The angle made by these three highlighted 
atoms is called the dihedral angle. A dihedral angle is an apparent angle made by four atoms, 
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three of which are visible and one of which is obscured. Look to the bottom right of the 
screen and see the dihedral angle is either + 60o or – 60o. The program measures the angle 
from the near bond to the rear bond. If the angle generated by going from the near bond to 
the rear bond is clockwise, the angle is a positive or (+) angle. A corresponding 
counterclockwise angle is negative (-). These conventions are specific to SpartanBuild. Click 
on the appropriate atoms to change your dihedral angle from - 60o to + 60o or visa versa.   
We are generally more interested in the magnitude than we are of the sign of a dihedral 
angle.  
 
  ◦Define Point Clear the screen and build a model of methane. Open the 
Model menu and ensure that only the Ball and Wire and Hydrogens options are checked. 
With methane on the screen, click “Define Point” from the “Geometry” menu. The model 
now appears as a ball and wire model, regardless of what kind of model was previously on 
the screen. Click on the carbon atom. The carbon atom is highlighted by turning a golden 
color. In turn, click on each of the H atoms. Each H atom is highlighted as you click it. When 
every atom in your model has been highlighted, click any of the highlighted atoms. The 
model reverts to a ball and wire model with no highlighted atoms. With the define point 
command active, take care to click in the center of the carbon atom. The carbon atom is 
highlighted by turning golden. Click in the center of the C atom again. The highlight is 
removed and the model appears to be the same as is was before. Click on the “V” icon, the 
select “Wire” from the “Model” menu. You see that the carbon atom has been made the 
“defined point.” Thus, double clicking an atom when the Define Point command is active 
creates a visible ball on wire models. The defined point is invisible in the other models. Clear 
the model from the screen, and build a new methane molecule. Click “Define Point” from the 
“Geometry” menu. Click on carbon, then any hydrogen, then on carbon again. A point is 
created midway between the two atoms. This point is visible on the ball and wire model 
because the point does not coincide with an atom. Three clicks are required to make a point 
between two atoms; whereas, only two clicks are required to make an atom a point. Points 
can be made between any and all bonds in the model and at any or all atoms. All points are 
visible on the wire model. Clear the screen. 
 
  ◦Define Plane With a new methane on the screen, click “Define Plane” from 
the “Geometry” menu. The model now appears as a ball and wire model, regardless of what 
kind of model was previously on the screen. Click on the carbon and on two hydrogen atoms. 
A plane, connecting the three atoms, appears. Click on carbon and on the other two hydrogen 
atoms. A new plane appears. Select both “Hydrogens” and “Labels” from the “Model” menu. 
The hydrogen atoms disappear, and the planes are labeled plane 1 and plane 2. Select “Wire” 
from the “Model” menu. What is the relationship between plane 1 and plane 2? Hint: rotate 
the molecule so that neither plane is visible. Clear the screen. 
___________________________________________________________________________ 
The above examples show how the point and plane options can be helpful in the visualization 
of models. 
 
►User Options◄ Most user options are associated with the Options menu. 
 
 ●Options Click on “Options” to open the options menu. You see three options above 
a line and three options below the line. The three options below the line are already checked, 
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meaning they are active or visible on your screen. The three options above the line are 
“About SpartanBuild…, Preferences …, and Colors…” This top option gives us information 
about the company that developed Spartan and the other five options give us alternative ways 
to setup or modify what we see on the screen.  
 
  ◦About SpartanBuild….. Click “About SpartanBuild” from the “Options” 
menu. A window opens that provides information on how to contact Wavefunction, the 
company that makes Spartan software. Note, the WFKIT icon you clicked to open the model 
kit stands for Wavefunction kit. Click on “OK” and the window disappears. 
 
  ◦Preferences With methane on the screen in a ball and spoke model, click on 
“Preferences” from the “Options” menu. A new window labeled Preferences opens. The 
preferences window offers the viewer three basic options, “View, Stereo, and Toolbar Style.” 
If the preferences window obscures your model, move one or both of them in the usual 
manner so that methane is visible on your screen. The preferences window can be moved by 
depressing and holding the LMK with the pointer in the blue field in which the word 
Preferences appears, and then dragging the window to the desired location on the screen with 
the LMK depressed. The View and Stereo options determine how the molecule appears on 
the screen. The Toolbar options give the viewer three different ways to display the Toolbar. 
   ·Stereo The default View selection is titled “Orthogonal.” With 
“Orthogonal” selected, check “Stereo” then click “OK” in the “Preferences” window. The 
window disappears and the methane model is now viewable in stereo. That is, when viewed 
through the red and blue stereo glasses, the model appears to be in three dimensions. If you 
have stereo glasses, view the methane model through these glasses. Reopen “Preferences” 
from the “Options” menu. Select “Perspective” from the View menu. Note that one of the 
two choices, Orthogonal or Perspective, will always be active. With “Stereo” still checked, 
click on “OK.” The methane model now appears even better when viewed through the 3d 
glasses. Thus, we will generally use the Orthogonal selection without Stereo and the 
Perspective selection with Stereo. Reopen the “Preferences” window and click on 
“Orthogonal” and “Stereo,” then click “OK.” The window disappears, and the methane 
model returns to a standard ball and spoke model. 
  
   ·Toolbar Style We shall examine the use of the toolbar icons in the 
next segment. For now, we will learn three different ways to display the toolbar. The default 
toolbar style is “Small Icons”. Open the “Preferences” window from the “Options” menu. In 
turn, click on “Text and OK”, “Large Icons and OK”, and “Small Icons and OK.” The 
Preferences window must be reopened each time. Note how the toolbar changes on your 
screen. The last-selected style remains active until the user changes it. 
 
  ◦Colors Click on “Colors” from the “Options” menu. A new window called 
Set Color appears. This window controls the background color you see on the screen. The 
default color is a green background. The Set Color window contains three scrollable options 
made up of the three primary colors, Red, Green, and Blue. Depress and hold the LMK on 
the scrollbar under “Blue.” With the LMK depressed, scroll the bar upward and notice that 
the screen turns blue. With the three scrollable keys, you can adjust the background color on 
the screen to any color you please. Make several color adjustments, then click the “Default” 
option. The original green background color returns. Adjust the background color to the color 
of your choice. There are two red boxes on your screen with an X. Take care to be in the Set 
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Color box and click the X in the upper right corner of the active window. The new 
background color remains active until changed. If you accidentally click the wrong red box, 
you must reload SpartanBuild.  
 
  ◦Model Kit, Build Toolbar, Geometry Toolbar Click on “Options” to open 
the options menu. The three choices below the line are already checked. Checked items are 
visible on your screen.  

·Model Kit Click on “Model Kit.” The model (atom selection) kit 
disappears. Click on “Model Kit,” again from the Options menu and the atom selection kit 
reappears. Thus, you have a choice of viewing the kit or not viewing the kit. Obviously, 
when you are building a model, you’ll want to view the kit.   

 
·Build Toolbar Click on “Build Toolbar.” The Build Toolbar consists 

of the first six icons on the toolbar at the top of the screen. These six icons disappear when 
the Build Toolbar is unchecked in the Options menu. Click on “Build Toolbar” again from 
the Options menu and the six icons reappear. Selecting one of the six icons in this group is 
the same as selecting that option from the Build menu as discussed above. 

 
·Geometry Toolbar Click on the “Geometry Toolbar.” The Geometry 

Toolbar consists of the last five icons on the toolbar at the top of the screen. These five icons 
disappear when the Geometry Toolbar is unchecked in the Options menu. Click on 
“Geometry Toolbar” again from the Options menu and the five icons reappear. Selecting one 
of the five icons in this group is the same as selecting that option from the Geometry menu as 
discussed above.  

 
Before going on to the next section, make sure the Model Kit, Build Toolbar, and Geometry 
Toolbar are checked in the Options menu. Likewise, make sure that either Small Icons or 
Large Icons is selected in the Preferences window of the Options menu. 
 
►Shortcuts◄ Most shortcuts are associated with the Toolbar icons. 
 
►Toolbar Icons The eleven icons displayed at the top of the screen just below the menu 
items are shortcuts to the six options in the Build menu and five options in the Geometry 
menu, which we have already discussed. The title of an icon is revealed when the cursor is 
placed over the icon without clicking the mouse. The title of an icon disappears in about five 
seconds. Slowly move the pointer over each of the first six icons, starting with the “V” icon, 
until the title of each icon appears. You will note that the first six icons have the same names 
as the six options in the Build menu. Thus, these six icons are collectively known as the 
Build Toolbar. Likewise, the final five icons have the same names as the five options in the 
Geometry menu. Hence, these five icons are collectively known as the Geometry Toolbar. 
Clicking on any one of the eleven icons is the same as selecting the corresponding name from 
the Build or Geometry menu. Thus, you save a mouse click each time you use the toolbar 
instead of the Build or Geometry menus. 
 

●Distance With a methane molecule on the screen, click on the “Distance” icon. The 
icon is active when it appears slightly depressed. Next, click on the midpoint of any C—H 
bond and read the bond length at the bottom right of the screen. Note, this operation gives the 
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same result you found above. Like the Distance icon, the other 10 icons are shortcuts to menu 
selections. Two clicks are necessary to open a menu item, whereas the same operation is 
performed by a single click on the corresponding icon from the Toolbar. 
 
►Keystrokes for Manipulating Molecules in SpartanBuild The keystrokes for the 
fundamental manipulations possible in SpartanBuild are given in Table 1. 
 
Table 1. Keystrokes for SpartanBuild 
 
    Operation 
 

 
     Mode 

 
Keystrokes 

Translation 
Single Molecule 
All Molecules 
One of Multiple Molecules 

 
 
 
(+) highlighted 

 
RMK 
RMK 
Ctrl + RMK 

Rotation (three-dimensional) 
Single Molecule 
All Molecules 
One of Multiple Molecules 

 
 
 
(+) highlighted 

 
LMK 
LMK 
Ctrl + LMK 

Spin (two-dimensional)  
Single Molecule 
All Molecules 
One of Multiple Molecules 
About single bond 

 
 
 
(+) highlighted 
(+) select bond (dashed) 

 
Shift + LMK 
Shift + LMK 
Ctrl + Shift + LMK 
Alt + LMK 

Zoom 
Enlarge Molecule 
Reduce Molecule 

  
Shift + RMK (mouse ↑) 
Shift + RMK (mouse ↓) 

Change Bond Length 
Lengthen 
Shorten  

 
(+) select bond (dashed) 
(+) select bond (dashed) 

 
Alt + RMK (mouse ↑) 
Alt + RMK (mouse ↓) 
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Molecular Modeling Exercises 
 
The following exercises are designed to allow you to explore the build, view, and measure 
features of SpartanBuild, while collecting useful data about organic compounds. The 10 
questions at the end of the exercises require the data you acquire from these exercises. 
Therefore, answer the questions as you go along and keep them for the follow-on problems. 
 
Functional Groups: Functional groups are unique partial structures that allow organic 
compounds to be classified into families. Because each member of a family contains the 
same functional group, each member of the family reacts similarly. There are many organic 
families, which we can sub-divide into three major categories. These categories are (1) 
hydrocarbons, (2) compounds that contain a heteroatom, and (3) compounds that contain a 
carbonyl group. It is important to be able to identify functional groups, because they define 
the reactivity of the families to which they belong. Structure begets reactivity! 
 
Hydrocarbons: Hydrocarbons are compounds that contain only carbon and hydrogen. They 
may contain rings (i.e., be cyclic) or they may not contain any rings (i.e., be acyclic). The 
hydrocarbons are sub-divided into several families, depending on their structures. We shall 
consider the various hydrocarbon families. 
 
●Alkanes: Alkanes are hydrocarbons that contain σ bonds only. Alkanes may be cyclic or 
acyclic. Cyclic alkanes are called cycloalkanes. Alkanes are unique, because they do not 
contain a functional group. 
 
Note: The following exercises require the use of IUPAC numbering for the molecules, 
because the “Labels” option in the Model menu gives unpredictable numbers.  
 
►Ethane: Build and minimize a model of ethane (CH3CH3). Make and record the following 
measurements. C-H bond length __________ C-C bond length _________  H-C-H bond 
angle _________  What is the hybridization of an alkane carbon atom? _________ 
 
Hydrocarbons do not contain heteroatoms, and alkanes do not contain π bonds. However, 
other kinds of hydrocarbons do contain π bonds. The number of π bonds and their locations 
within a given structure determines the family to which a given hydrocarbon is assigned. The 
functional groups that may be present in hydrocarbons are a double bond, triple bond, and 
alternating single and double bonds in a six-membered ring. The families are alkenes, 
alkynes, and arenes, respectively. Figure 2 shows examples of these families. The next 
several exercises relate to these compounds. 
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Figure 2. Hydrocarbon Families 
 
 
●Alkenes: Alkenes contain one double bond that is made up of one σ bond and one π bond. 
A compound that contains two double bonds is called a diene, and one with three double 
bonds a triene, etc. Alkenes react primarily at the double bond or functional group. 
 
►Build and minimize a model of propene. What is the hybridization of C1? ________  
(Hybridization is not shown on the screen, you are supposed to know it!!!) What is the shape 
of the molecule around the double bond? ____________________ (Shapes are visible but not 
specified by the program, you must identify the shape.) What is the C1 to H1 bond length? 
____________  What is the C1 to C2 bond length? ___________  What is the angle made by 
the two hydrogen atoms and C1? _______________   
 
●Alkynes: Alkynes contain one triple bond that is made up of one σ bond and two π bonds. 
A compound that contains two triple bonds is called a diyne, and one that contains three is a 
triyne, etc. A compound that contains both a double and triple bond is an enyne (i.e., it 
contains three π bonds). Alkynes typically react at the triple bond or functional group. 
 
►Build and minimize a model of propyne. What is the hybridization of C1? __________ 
What is the shape of the molecule around the triple bond? ______________________ What 
is the C1 to H1 bond length? _____________ What is the C1 to C2 bond length? 
____________  What is the C1 to C2 to C3 bond angle? ________________  
 
●Arenes: Arenes contain an aromatic ring, a six-membered ring with alternating single and 
double bonds. Benzene is the first or simplest member of the arene family.   
 
► Build a model of benzene, using the Rings command, minimize the structure and label it. 
What is the hybridization of C1? __________ What is shape of the molecule? 
______________________ What is the C1 to H1 bond length? _____________ What is the 
C1 to C2 bond length? ____________  What is the C2 to C3 bond length? _____________ 
What is the C1 to C2 to C3 bond angle? ________________ 
 
Isomers: Isomers have the same molecular formula (i.e., the same numbers and kinds of 
atoms) but differ in structure. There are several different kinds of isomerism. Two of the 
most important kinds are constitutional isomerism and cis—trans isomerism. 
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●Constitutional Isomers:  Constitutional isomers differ in the way their atoms are 
connected to each other (i.e., their connectivity). Figure 3 shows three alkanes that each 
contains five carbon atoms. 

n-pentane
pentane

isopentane
2-methylbutane

neopentane
2,2-dimethylpropane

 
Figure 3. Five-carbon alkanes 
 
►Build models of pentane, 2-methylbutane, and 2,2-dimethylpropane on the same screen, 
and scale them to fit on the screen so that all of them are visible. Minimize but do not label 
the structures. What is the formula of pentane?_______________, of 2-methylbutane? 
____________, and 2,2-dimethylpropane? _________________ Are these compounds 
isomers? ____ What kind of isomers?_______________________________________ 
Measure the distance between the terminal carbon atoms (IUPAC numbering) in each 
compound. C-1 to C-5 in pentane _______ C-1 to C-4 in 2-methylbutane _____ and C-1 to 
C-3 in 2,2-dimethylpropane ________ Convert all of the models into space-filled models. If 
they overlap, go to build (+), and move and or scale the molecules so that each is observable 
as a space-filled model. Which compound is most compact (most closely resembles a ball)? 
_______________________________Which compound is least compact? 
_____________________________  
 
●cis—trans Isomerism: Cis is a term that means two groups are on the same side of a 
molecule, and trans means that two groups are across from each other in a molecule. In order 
to have cis—trans isomers, the molecule must clearly have two identifiable “sides.” The 
necessary condition for cis—trans isomerism is afforded by carbon—carbon double bonds 
and by rings (i.e., alkenes and cycloalkanes). Figure 4 shows how the two “sides” are 
identified. 
 

 

C C
A

E

B

F

red side

blue side

A D

GE

B

F

red side

blue side

  
Figure 4. Cis-trans Isomerism 
 
The double bond of an alkene determines the “sides.” The double bond is extended as shown 
by the dashed magenta line in Figure 4, and the sides lie on either side of the magenta line. 
For a cycloalkane, the ring determines the sides. Though most rings are not planar, once a 
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structure is drawn, we can clearly identify whether a group is one side or the other as shown 
in red and blue in Figure 4. In general, we compare only two groups at a time. Cis means the 
two groups that we mention are on the same side (either the red side or blue side in Figure 4). 
Trans means that the two groups we mention are on opposite sides of the ring and across the 
ring; two groups that are trans are not bonded to the same atom. Thus, A and E are not trans 
in either structure of Figure 4. For the alkene, A and B and E and F are cis; A and F and B 
and E are trans. For the cylcoalkane, A is cis to B and to D; A is trans to F and to G but not to 
E. Note that A and B are on the same side of the ring but not next to each other. Cis only 
means “same side.”  
Cis—trans isomers do not differ in connectivity. Exactly the same atoms are bonded to each 
other in both compounds. Cis—trans isomers differ in their three-dimensional geometry. 
They are an example of stereoisomers. There are other examples of stereoisomers not 
covered here. 
 
►Build models of the compounds shown in Figure 5 on the same screen of SpartanBuild and 
minimize. 

 
Figure 5 Alkenes 
 
In one of the molecules, the two methyl groups are on the same side and in the other they are 
across from each other. Use the stereochemical prefixes cis and trans to name these 
compounds. __________________________________________ and 
__________________________ The prefix precedes the rest of the name. When cis or trans 
becomes part of a name, it is italicized. For example, cis-1,3-dimethylcyclopentane. In the 
future, when you see cis (or trans) as an italicized prefix, be aware that there is a trans (or cis) 
stereoisomer! Change the view to space filling. Which of the space-filled molecules seems to 
be more compact?_____________________  
 
►Build models of the compounds shown in Figure 6 on the same screen of SpartanBuild and 
minimize. 

CH3 CH3 CH3

CH3

 
Figure 6. Cycloalkanes 
 
Name these compounds, ______________________________________________________ 
and ______________________________________________________________________. 
Do either of the compounds have a perfectly planar ring? _______ Explain any differences 
you observe in the SpartanBuild models vs the structures as they appear in Figure 6. 
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___________________________________________________________________________
___________________________________________________________________________ 
Measure the angle made by any three of the ring carbon atoms. _________ Subtract your 
answer from the tetrahedral angle of 109.5o? ____________ The difference is a measure of 
the angle strain in the molecule. Angle strain is the number of degrees the normal tetrahedral 
angle is compressed from its normal value of 109.5o. Start with either red carbon atom of 
Figure 6 in the cis-isomer and measure the dihedral angle made by the four carbon atoms, 
red-ring-ring-red. _________ The smaller the dihedral angle, the greater is the torsional 
strain. In the trans-isomer, measure the dihedral angle made by the four carbon atoms blue-
ring-ring-blue. ______________ Which isomer has the greater torsional 
strain?_____________ View the molecules as space-filled models. Locate the two methyl 
groups in each model. When adjacent groups are closer together than the sum of their van der 
Waals radii, both groups try to occupy the same space. When two groups touch each other, 
we call it a steric (spacial) interaction. The stain that a spacial interaction places on a 
molecule is called steric strain. Which isomer has the greater steric strain? 
____________________ 
 
 
Organic Families Containing a Single-bonded Heteroatom: Heteroatoms are any atoms 
other than carbon or hydrogen. For most purposes, heteroatoms are nitrogen, oxygen, sulfur, 
or a halogen (fluorine, chlorine, bromine, or iodine). Although nitrogen, oxygen, and sulfur 
can form multiple bonds, this group of families contains these atoms only with single bonds. 
Examples of families in this group are alkyl halides, alcohols, ethers, amines, thiols, and 
sulfides. Ethers and sulfides are derivatives of alcohols and thiols, respectively. They are 
covered elsewhere. Figure 7 shows an example of an amine, an alcohol, a thiol, and four 
alkyl halides.  
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Figure 7. Families with Single-bond Heteroatoms 
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The families are arranged in Figure 7 according to the location of the heteroatom in the 
periodic table. Note that nitrogen has three bonds, oxygen and sulfur two bonds each, and 
fluorine, chlorine, bromine, and iodine one bond each, a reflection of the periodic groups of 
these atoms. The methyl group in each of the structures is the organic part, the colored part of 
each molecule is the functional group that defines the family. Reactions involving these 
molecules will generally occur at the functional group. The four alkyl halides are considered 
to be one family with four sub-families. The names of the compounds in Figure 7 are 
methanamine, methanol, methanethiol, and fluoromethane, chloromethane, bromomethane, 
and iodomethane. 
 
●Alkyl Halides: Alkyl groups are alkanes with one H atom missing. When the missing H is 
replaced by a halogen, F, Cl, Br, or I, the compound is an alkyl halide.  
 
►Build models of fluoromethane, chloromethane, bromomethane and iodomethane and 
minimize them. While still in the build mode, rotate the molecules so that the halogen atom 
completely obscures the carbon atom. Arrange the molecules left to right, fluoride, chloride, 
bromide, and iodide. View all of the molecules as space-filled models. What is the order of 
increasing size of the halogen atoms? ______________    Delete all of the models except the 
bromide. Click the “Define Plane” icon. Make a plane on the model by clicking the three H 
atoms. Rotate the molecule until only the plane and the three H atoms are visible. Build a 
separate hydroxide ion on the screen (“Insert  “-O-”  “Delete”  click on one yellow tip 
of —O—   to make –O).  Move the –O to the center of the green plane, and then minimize. 
What angle in degrees is made by the Br-C-O atoms (rotate the pair until you can clearly see 
the angle)? _________ When hydroxide reacts with an alkyl halide it bonds to the back side 
of the carbon as the halide leaves from the front side.  
 
●Alcohols:  Alcohols contain an alkyl group and a hydroxyl group (-OH), the functional 
group. The hydroxyl group (-OH) replaces the missing H atom. If you start with water (H-O-
H) and replace one of the H atoms with an alkyl group, you make an alcohol. Alcohols 
generally react at the OH group. 
 
►Build two models of methyl alcohol (methanol) on the same screen. The second model is 
active (has yellow tips). Move it so that the yellow tip from the red oxygen touches the red 
oxygen of the first molecule, and the alkyl part of the second alcohol is as far away from the 
first alkyl group as possible. Build a third model of methyl alcohol. Move it so that its H 
from OH just touches the red O of the second model, while ensuring that the alkyl groups are 
as far from each other as possible. Click E to minimize. You have an array of three 
molecules. There is an endless array of methyl alcohol molecules in a sample of methyl 
alcohol. Hydrogen bonding exists in organic compounds when an H atom is bonded to either 
an N or O atom and is attracted through space to another N or O atom. Hydrogen bonds are 
strong dipole—dipole forces of attraction. When they are present in liquids, the boiling point 
of the liquid is higher than that of similar compounds, which do not possess hydrogen 
bonding. Does your array of molecules depict hydrogen bonding? ________ Describe 
hydrogen bonding in alcohols.   
 
●Amines: Amines contain an alkyl group and an amino (-NH2) group, which is the 
functional group. Amines generally react at the –NH2 group. 
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►Build a model of methylamine (methanamine) and minimize the structure. Can you 
distinguish the carbon atom from the nitrogen atom by color? _______ Can you distinguish C 
from N by number of H atoms bonded to them? ______ Make the model as large as possible 
but still on the screen. Now, can you distinguish N from C in the model by color? ______ 
What color is the C atom? ______ The N atom? ______ In a Lewis structure of methyl 
amine, the N atom has a lone pair of electrons. Where is the lone pair in the model? 
 
●Thiols: Thiols contain an alkyl group and a mecapto group (-SH), which is the functional 
group. The prefix thio means sulfur, so thiols are –ols (alcohols) that contain sulfur instead of 
oxygen. Indeed, thiols can be considered compounds in which the O of an alcohol has been 
replaced by S. Thiols are important in certain biochemical processes. Thiols generally 
undergo reactions in which the mercapto group participates. 
 
►Build a model of methanethiol and minimize it. What color is the sulfur atom? 
__________ 
 
Organic Families Containing a Carbonyl Group: A carbonyl group is a carbon and 
oxygen atom joined by a double bond. The carbon atom of the carbonyl group has two open 
valences.  
 

C
O

carbonyl group

squiggly indicates
open valence

 
 
Several different kinds of groups or atoms can be bonded to these two valences, giving rise to 
a number of families that contain the carbonyl group as a central structural feature. Examples 
of families in this group are aldehydes, ketones, carboxylic acids, esters, amides, and acid 
chlorides. For convenience, this group can be broken into two sub-groups. One group is 
comprised of aldehydes and ketones, and the other group is comprised of carboxylic acids 
and derivatives of them.  
 
●Aldehydes and Ketones: Aldehydes and ketones contain a carbonyl group but no 
additional heteroatoms. Aldehydes must contain one H atom bonded directly to the carbonyl 
carbon atom. If both of the open valences of the carbonyl group are bonded to H atoms, the 
compound is the aldehyde called methanal or formaldehyde. Ketones must contain two 
carbon atoms bonded to the carbonyl carbon atom. Figure 8 shows examples of aldehydes 
and ketones. The carbonyl group, shown in blue, is always present in aldehydes and ketones. 
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Figure 8. Aldehydes and Ketones 
 
►Build models of formaldehyde, acetaldehyde and acetone on the same screen and click E. 
Measure and record the oxygen to carbon double bond length in each. _______ _______ and 
____________ Measure and record one angle in each compound in which the carbonyl 
carbon is the middle atom. _______ _________ _________ View the molecules as tubes. 
What is the geometry around the carbonyl group? _____________________ What structural 
feature is necessary for a pure sample of a given compound to form intermolecular hydrogen 
bonds? __________________________________________From the structures in Figure 8, 
can a pure aldehyde form intermolecular hydrogen bonds? ____________ 
 
●Acids and Acid Derivatives: Carboxylic acids contain a hydroxyl group bonded directly to 
the carbonyl carbon. Esters, amides, and acid chlorides are derivatives of carboxylic acids in 
which the H or OH of the acid’s hydroxyl group has been replaced. Acids and acid 
derivatives are characterized by a heteroatom bonded to the carbonyl carbon. Figure 9 shows 
examples of these families. The carbonyl group, which is always present in carboxylic acids 
and acid derivatives, is shown in blue. The heteroatom bonded to the carbonyl carbon in 
these compounds is highlighted in red. 
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Figure 9. Acetic Acid and its Acid Derivatives 
 
►Build and minimize a model of acetic acid. View the molecule as a ball and spoke model. 
Change the model, in turn, into ethyl acetate, acetamide, and acetyl chloride. Change acetyl 
chloride into acetyl bromide. What is the structure of the acetyl group?________________ 
 
☺This completes the tutorial. Ten questions that review SpartanBuild are provided on the 
next page. 
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Questions Electronic Models 

 
1. What angle strain did you find in the cyclobutane ring? _________ Find the angle strain in 
cyclopentane. The angle strain in cyclopentane is ___________________ . 
 
2. Build a model of cyclohexane in SpartanBuild and minimize it. Is the ring planar? ______ 
Delete the hydrogen atoms (“Model”  “Hydrogens”). Describe the shape of the carbon ring 
system. ____________________ 
 
3. From your lab results, which stereoisomer, cis-1,2-dimethylcyclobutane or trans-1,2-
dimethylcyclobutane, has the higher overall strain (i.e., sum of angle, torsional, and steric 
strains)? 
 
4. From your model building results, what is the relationship between branching in alkane 
constitutional isomers and the compactness of the molecules?  
 
When a compound boils, the molecules of the compound are separated (pushed apart) by the 
application of heat. In a series of isomeric compounds, the most heat is required to separate 
the molecules of the isomer with the strongest intermolecular forces. Thus, that isomer has 
the highest boiling point of the group. Likewise, the least amount of heat is required to 
separate the molecules of the isomer with the weakest intermolecular forces. Thus, that 
isomer has the lowest boiling point of the group. In the alkane family, what is the relationship 
between compactness and intermolecular forces? 
 
Finally, for the alkane family, what is the relationship between compactness and boiling 
point? 
 
From your analysis, rank order pentane, 2-methylbutane, and 2,2-dimethylpropane in order 
of increasing boiling point. 
 
 
 
 
 (Use the Internet to verify your conclusion. If your initial conclusion is incorrect, go back 
through this question until you understand: small diameter space-filled model = compact 
molecule = weak intermolecular forces = low bp.) 
 
5. From your results, what is the bond length of the double bond in a carbonyl group, 
rounded to two significant figures?  
 
6. Does methanol or methanal (formaldehyde) have the higher boiling point? 
Explain why your answer is correct. 
 
 
7. What is the hybridization of a carbonyl carbon atom? 
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8. Write the family name beneath each of the following structures. 

CH3CH2COH

O

CH3CH2CH

O
CH3CH2COCH2CH3

O

 
       
 
9. Build models of cyclopropane and cyclohexane in SpartanBuild. Measure the dihedral 
angle between adjacent cis hydrogen atoms in each structure. Which molecule has the larger 
torsional strain? 
Explain how torsional strain is a function of dihedral angle. 
 
10. From data you collected during the exercises, complete the following table. 
 
Kind of Bond 
 

 
             Structure  

 
Bond Length  
(rounded to 0.1 Å) 

 
sp3 carbon-hydrogen 
 

 
               C-H 

 
      1.1  

 
sp2 carbon-hydrogen 
 

 
 
 

 

 
sp carbon-hydrogen 
 

 
 
 

 

 
sp3 carbon- sp3 carbon 
 

 
 
 

 

 
sp2 carbon- sp2 carbon 
 

 
 

 

 
sp carbon- sp carbon 
 

 
 
 

 

 
arene carbon-arene carbon 

 
 
 

 

  
 
 
 
.  
 
 
  
 
 


